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MWS2012 ハンズオン 
インシデントレスポンス 



準備 

• ハンズオンで使用するファイル群のコピー 
– USBメモリ内のmws2012フォルダをホストOSのC:¥に

コピー 
• leaked_file 

– 漏洩したファイルを含む圧縮ファイル 

• WinHost 
– ホストOSで使用するデータ、ツール 

• WinVM 
– ゲストOS（Windows）で使用するデータ、ツール 

• Documents 
– ハンズオン資料、フォレンジック解析に関する解説文書 

• ディスクイメージの展開 
– C:¥mws2012¥WinHost¥acquired_disk_image¥win

7usp1.zip 
– ディスクイメージはハンズオンが終わったら削除してく

ださい 
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hands-on 
Host OS 



調査開始までのあらすじ 

• あなたは某社でインシデントレスポンスを行う
エンジニア 

• あなたは顧客から「弊社の機密情報がインター
ネット上になぜか漏洩している。原因を調べて
ほしい」との依頼を受ける 

• ヒアリングとファイルサーバのログ調査を行っ
たところ、不審な一台の端末が特定され、手始
めにその端末を解析することになった 
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Client A(win7usp1) 
Windows 7 SP1 
 (一般社員okitaが
利用) 

ローカルネットワーク (192.168.52.0/24) 

Client B (winxpsp3) 
Windows XP SP3 

（ネットワーク管理者
kondoが利用） 

Client C (vistaesp2) 
Windows Vista SP2 
（重役toshiが 
利用） 

ファイル共有/web 
サーバ(2003r2fs) 
Windows Server 
2003 r2 SP2 

DC/内部DNSサー
バ (2008r2dc) 
Windows Server 
2008 r2 SP1 

外部DNS/メールサー
バ/Firewall/GW(mail) 
Cent OS 6 

インターネット 

.32 

.50 .52 .51 .34 .33 

Domain : shinsen-group 

ネットワーク構成 

今回の解析対象： 
重役toshiのアカウントで 

ファイルサーバにアクセス？ 
（本人にその覚えはない、 

アカウント情報も知らない） 
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インシデント対応における解析のフロー 

フォレンジック解析 マルウェア解析 

今回の 
解析範囲 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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本ケースの解析内容 
• タイムラインの作成 
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– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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SIFTのVM設定、ログイン確認 

• フォルダの共有設定 
– SIFTからホストのイメージファイルにアクセス可能にする 

• [VM] -> [設定]から[オプション]タブを選択 

• ログインできることを確認 
– パワーオン、ID=sansforensics, password=forensicsでログイン 

• 使用しているVMWareが古くて起動しない場合は、 以下の設定を参照
C:¥mws2012¥WinHost¥conf¥VMWare¥Workstation_SIFT_setting.txt 
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タイムラインの作成 
• ファイルシステム・レジストリ等、様々なタイムスタンプを

１つにまとめて表示 
• マルウェアによる感染痕跡が残りやすい個所を調べて時刻を

絞り込む 
– 事前にもらった情報（マルウェアのアクセス先URL等）があれ

ばそれを利用 

• 絞り込んだ時刻の前後の活動を芋づる式に抽出していく 
– 前：感染原因 
– 後：マルウェアや攻撃者による活動 

log2timeline 

ファイルシステム 

レジストリ 

web履歴 

プログラム実行履歴 

CSV出力、EXCELで表示 
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タイムラインの作成(Cont.) 
• SIFTのlog2timeline-sift 

– 生成 
• log2timeline-sift -win7 -z Japan –i イメージファイルのパス 

• ホストOS側と共有設定していれば、ホストOSのCドライブを
/mnt/hgfsもしくはデスクトップから参照可能 

• 詳しいコマンドオプションは以下を参照のこと 
– C:¥mws2012¥Documents¥log2timeline-cheatsheet.pdf 
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タイムラインの作成(Cont.) 
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• SIFTのlog2timeline-sift 
– 期間でフィルタリング 

• l2t_process -b /cases/timeline-output-folder/イメ
ージファイル名_bodyfile.txt  

 開始日(..終了日) > 出力csvファイルのパス 

 

 



タイムラインの作成(Cont.) 
• SIFTのlog2timeline-sift 

– 抽出されたエントリのソースタイプを確認 
• awk -F, ‘{print $6;}’ フィルタした後のcsvのパス | grep -v 

sourcetype | sort | uniq 

– 処理の過程で抜け落ちるソースが存在 
• v2.13の場合、イベントログがタイムラインに含まれてこない 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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自動起動設定プログラムの調査 

• マルウェアはシステム起動時・ログイン時に自
身を実行するための設定を登録することが多い 
– 感染時期や原因、マルウェアに関する情報等が事前

に無い場合、まずは起動設定を調べる 

• AutoRuns 
– レジストリやスタートアップ等、自動起動設定に関

する情報を一括表示 
– 起動中のシステムだけでなく、オフラインのシステ

ムボリュームの設定を表示することも可能 

• FTK Imager 
– 保全したディスクイメージをマウント 
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ハンズオン#1:自動起動設定プログラムの調査 

• FTK Imager 
– インストール 

• C:¥mws2012¥Win
Host¥tools¥Access
Data%20FTK%20I
mager.exe 

–  [File] -> [Image 
Mounting...] 
1. イメージファイル

を指定 
2. マウント 
3. Mapped Images

を確認 
– AutoRunsで指定

すべきボリューム
を判別 
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ボリュームレター：E
にマウントされた 

① 

② 

③ 

hands-on 
Host OS 



ハンズオン#1:自動起動設定プログラムの調査
(Cont.) 

• AutoRuns 
– "C:¥mws2012¥WinHost¥tools¥Autoruns.zip"を展開、autoruns.exeを

管理者権限で実行 
– [File] -> [Analyze Offline System...] 

1. System Rootに「レター番号:¥Windows」をセット 
2. User Profileに「レター番号:¥Users¥okita」をセット 

– [Options] -> [Filter Options]でノイズを除去 
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※ HKLM (Hive Key Local Machine): システムレジストリ 
    HKCU (Hive Key Current User): 指定したユーザプロファイルのレジストリ 

① 

② 

hands-on 
Host OS 



本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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マルウェアの登録時刻の特定 

• レジストリキーには最終更新時刻の情報が
含まれる 
– AutoRunsで発見した不審なエントリが追加

された時刻を特定し、それ以前のタイムライ
ンを遡っていく 

• Registry Decoder 
– ディスクイメージ、レジストリファイルを解

析してレジストリの情報を検索・表示 

• Digital Forensic Framework 
– 削除・未使用領域を含めたファイルの検索、

表示、抽出 
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マルウェアの登録時刻の特定(Cont.) 

• SIFTのDigital Forensic Framework 
– SIFT VMメニューバーのアイコンをクリック 
– [File] -> [Open evidence file(s)] 
– ①ファイルフォーマット、②読み込むイメージファイルを指定 
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① 

② 



マルウェアの登録時刻の特定(Cont.) 

• SIFTのDigital Forensic Framework 
– 対応するモジュールを指定してNTFSをパース 

• [Relevant module] -> ①partition, ②ntfs 
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① 

② 



マルウェアの登録時刻の特定(Cont.) 

• SIFTのDigital Forensic Framework 
– 対象のレジストリファイルを抽出 

• 保存先はホストOSのファイルシステムのフォルダを指
定 
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マルウェアの登録時刻の特定(Cont.) 
• Registry Decoder 

– "C:¥mws2012¥WinHost¥tools¥regedcoderR103.zip"を展開、regdecoderR103.exeを
実行 

– [Start a new case]を選択、Next 
– ケースの作成 

• Case Directoryは必ず空のフォルダを指定 

– レジストリファイルの追加 
• Add Evidenceで抽出したレジストリファイルを選択 
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ケースの作成 

レジストリファイルの追加 



マルウェアの登録時刻の特定(Cont.) 
• Registry Decoder 

– ブラウジング 
• [File View] タブでレジストリファイルを選択、 [View] をクリック 
• [Browse] タブが開くので、注目しているレジストリパスをたどる 
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Runキーの最終更新時刻 
（上書きされる可能性あり） 



マルウェアの登録時刻の特定(Cont.) 

• Registry Decoder 
• 検索 

1. [Search] タブで対象のレジストリファイルを選択 
2. [Search Term] 内でキーワードを入力 
3. [Partial Search] を選択 
4. 検索対象を全てチェック 
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① 

② 

③ 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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タイムラインのチェック 

• 感染原因に迫るアプローチ 
– 自動起動設定されているwmi.exeの様々なタイム

スタンプを参照する 
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Registry 
key 

Filesystem Prefetch ShimCache 

Description last written 
time 

MACB times first & last 
run time 

file 
modification 
time 

Tool log2timeline, 
Registry 
Decoder 

log2timeline Windows 
Prefetch 
Parser 

ShimCache 
Parser 

Risk 別のエントリ
による上書き 

マルウェアや
攻撃者による
変更 

SSD/ESXiの
イメージ 

? 
(シャットダ
ウンが必要) 

Result 2012/10/5  
18:48:30 

2012/10/5  
17:05:56 

無 2012/10/5  
17:05:56 



ハンズオン#2:タイムラインのチェック 

• log2timeline-siftが生成したCSVをチェック 
– C:¥mws2012¥WinHost¥timeline¥win7usp1-

current¥20120901-win7usp1-bodyfile.zipを展
開、CSVをExcelでオープン 
• Officeが無い場合、SIFT内の表計算ソフトも利用可能 
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hands-on 
Host OS 

既に削除されているエントリの場合、 
パスの後ろに(deleted)が入る 

modification/last access/entry modified/creation 

タイムスタンプの種類を表す 

A, B,D,E, F, Mのカラムに 

注目する 



ハンズオン#2:タイムラインのチェック
(Cont.) 

• ShimCacheに残っていたファイルの更新時刻から、直前の活動を遡る 
– ファイルの生成 

• C:/Users/okita/AppData/Local/~EFGOI.tmp 

– デスクトップからWordファイルをオープン 
• taiseihoukan.doc 
• Flashオブジェクトを含む？ 

• 以下の疑問について確認していく 
– 「~EFGOI.tmp」とは何か？ 
– 「taiseihoukan.doc」はどこから来たファイルか？（e.g., web or mail） 
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hands-on 
Host OS 



ファイルの内容や由来に関する調査 

• 「~EFGOI.tmp」とは何か？ 
– Digital Forensic Frameworkを用いたハッシュ値の照合 

• “~EFGOI.tmp”と”wmi.exe”は同一のファイル 

 
• 「taiseihoukan.doc」はどこから来たファイルか？ 

– web履歴（explorerによるファイルアクセスも残る） 
• Web Historian 

– writableで再マウント、ホームフォルダにアクセスしてアクセス権限を取得 

– メールの調査 
• Thunderbirdのメールフォルダを抽出、 VM上にセットアップしたThunderbirdに読み込み 

– Users/okita/AppData/Roaming/Thunderbird/Profiles/*.default/Mail 
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2012/10/5  

17:05:10送信の 

「大政奉還（修正版）」 

”taiseihoukan.doc” 

が添付されている 



ユーザ活動の調査 

• ユーザが実行したGUIプログラムの調査 
– ユーザレジストリのUserAssistキー（実行回数、最後

に実行された時刻） 
– Registry DecoderのUser Assistプラグイン 

• ファイルのオープンに関する調査 
– Officeの最近開いたファイル 

• C:¥Users¥<user>¥AppData¥Roaming¥Microsoft¥Office
¥Recent¥ 

– JumpList 
• C:¥Users¥user¥AppData¥Roaming¥Microsoft¥Windows

¥Recent 
• JumpLister 

– ユーザレジストリ 
• Shell Bag, RecentDocs, etc.. 
• Registry Decoderの各プラグイン（Searchも有効） 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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Officeドキュメントの解析 

• embeddedなコード・ファイルの確認 
–文字列検索 

•Flash/JavaScript/ActiveXコンポーネント
(ScriptBridge), etc.. 

•文字列抽出ツール、バイナリエディタを使う 
–e.g., BinText 

–OLE構造をパースして確認 
•FileInsight 
•Pyew/hachoir-subfile (REMnuxに収録） 

• スキャン 
–OfficeMalScanner 

•実行ファイル・シェルコード、swfの抽出 
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Officeドキュメントの解析(Cont.) 

• FileInsight 
– VM内の

"C:¥mws2012¥WinVM¥tools¥fileinsight.exe"を実行
してインストール 

– taiseihoukan.docを読み込んで中身を確認 
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Flashファイルのシグネチャ 



Officeドキュメントの解析(Cont.) 

• OfficeMalScanner 
– VM内の"C:¥mws2012¥WinVM¥tools¥OfficeMalScanner.zip"を展開 
– OfficeMalScanner.exeのscanコマンドを実行 

• 実行ファイルやシェルコードのパターンを検索・抽出 
– bruteオプションでone-byte XORを試行 

• Flashファイルの抽出も可能 
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Flashの簡易解析 
• デコンパイルしたコードを確認 

– PDF Stream DumperのAS3 Sourcerer (評価版) 

• p-codeの確認 
– SWFInvestigator 

 

デコンパイルしたコード 
p-code 
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Flashの簡易解析(Cont.) 
• PDF Stream Dumper 

– VM内の"C:¥mws2012¥WinVM¥tools¥PDFStreamDumper_Setup.exe"を実行してイン
ストール 

– [Tools] -> [Decompile Flash w/ AS3 Sourcerer] 
– 評価版なので文字列コピー等の操作は不可 

• 特徴的な文字列をwebで検索 
– “Main_FontClass”、シェルコードの文字列 
– CVE-2012-1535？ 
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悪性文書ファイルの動的解析 
• CVE-2012-1535 

– Adobe Flash Player 11.3.300.270 およびそれ以前のバージョ
ンが対象 

– 感染端末のFlashのバージョンを調べる 
• SOFTWARE¥Microsoft¥Windows¥CurrentVersion¥Uninstall¥A

dobe Flash Player ActiveX 
– DisplayVersion = 11.2.202.233 

• 動的解析 
– 同じバージョンのFlashをインストールしたWindows VM上で

対象ドキュメントを開いて挙動を観察する 
• ファイル入出力、プロセスの動作解析 

– Process Hacker/Process Explorer 
– CaptureBAT 

• エミュレーションサーバ 
– FakeNet 

• レジストリ、ファイルシステム差分取得 
– regshot 

– Windows VMにOfficeをインストールしていない場合は、
wmi.exeを代わりに実行する 
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Windows VMの設定 
• VMWare Toolsをインストールしていない場合は入れておく 
• マルウェアを実行するので以下の設定を行う 

– ネットワークの設定をホストオンリーに 
– 実行前の状態に戻せるようにしておく 

• VMWare Workstationの場合、スナップショットを作成 
– [VM] -> [スナップショット] -> [スナップショットの作成] 

• VMWare Playerの場合、VM停止後に変更を破棄できるよう設定を編集 
– C:¥mws2012¥WinHost¥conf¥VMWare¥Player_Win_setting.txt 

• パワーオン、ログイン 
• ホストOSの"C:¥mws2012¥WinVM"をWindows VM内の

C:¥mws2012にコピー 
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hands-on 
Host OS 



ハンズオン#3: 
悪性文書ファイルの動的解析 

• VM内環境の準備 
– Flashのインストール 

• "C:¥mws2012¥WinVM¥tools¥flashplayer11_2r202_233_winax_32bit.exe"の実行 

– 動作確認 
• テスト用のコンテンツにIEでアクセス 

– "C:¥mws2012¥WinVM¥tools¥flash_IE_test_page¥moon.html“ 

– "C:¥mws2012¥WinVM¥extracted_malwares¥malwares.zip"を展開 
• パスワード：infected 

 
 

39 

hands-on 
VM 



ハンズオン#3: 
悪性文書ファイルの動的解析 

• CaptureBATのインストール 
– “C:¥mws2012¥WinVM¥tools¥CaptureBAT¥Cap

tureBAT.exe“を実行してインストール 
• インストールに失敗する場合、”Visual C++2005 

Redistrib Package.exe”を実行 

– インストール後、再起動が必要 
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hands-on 
VM 



ハンズオン#3: 
悪性文書ファイルの動的解析 

• Process Hacker 
– "C:¥mws2012¥WinVM¥tools¥processhacker-2.28-bin.zip"

を展開、x86¥ProcessHacker.exeを管理者権限で起動 
– プロセス、サービス、ネットワーク情報等を表示 

41 

hands-on 
VM 



ハンズオン#3: 
悪性文書ファイルの動的解析 

• FakeNet 
– ファイアーウォール設定の無効化 
– “C:¥mws2012¥WinVM¥tools¥Fakenet1.0c.zip”を展開、管理者権限のコ

マンドプロンプトから起動 
– nslookupコマンドでlocalhostに向くことを確認 
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hands-on 
VM 



ハンズオン#3: 
悪性文書ファイルの動的解析 

• CaptureBATの実行 
– 管理者権限のコマンドプロンプトから起動 

• 出力をリダイレクトして保存 
• -c: 変更もしくは削除されたファイルをキャプチャ 
• -n: ネットワークパケットをキャプチャ 

– 起動後、サービスがインストールされることを確認 
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ハンズオン#3: 
悪性文書ファイルの動的解析 

• regshot 
– 管理者権限で起動 

• "C:¥mws2012¥WinVM¥tools¥v5_regshot_1.8.3_beta1_win32_x64_src_bi
n_v5¥regshot.exe" 

– [Scan dir1...]をチェック、対象ディレクトリはC:¥ 
– [1st shot] -> [shot]をクリック 
– [2nd shot]が有効になっていることを確認 
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ハンズオン#3: 
悪性文書ファイルの動的解析 

• 悪性ドキュメントのオープン 
– "C:¥mws2012¥WinVM¥extracted_malwares¥malwares.zip"展開後の

taiseihoukan.docをオープン 
– VM内にOffice環境が無い場合、ドロップされたマルウェア(wmi.exe)を実

行してください 

• exploitが成功すると、ダミードキュメントが開く 
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ハンズオン#3: 
悪性文書ファイルの動的解析 

• ツールの終了、結果の確認 
– regshot（今回は未実施） 

• [2nd shot] -> [Compare] 
• 実行ファイルのインストール、レジストリ登録を確認 

– CaptureBAT 
• 適当にキーを押す 
• regshotの差分では把握できない詳細部分や削除ファイルの実体を参照 

– FakeNet 
• Ctrl-Cを押す 
• www.fewjriehgusuoh.comを名前解決、ポート80番にプロトコル不明な通信 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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シェルコードの解析 
• 補足：exploit後の動作をコードレベルで確認したい場合 

– デコンパイルしたコード or p-codeを読んでシェルコードを特定 
– swfファイルからシェルコードを抽出する 

• バイナリエディタ 

– シェルコードのエミュレーション（呼び出すAPIをチェック） 
• e.g., libemu 
• ただし、このシェルコードには効果がない 

– シェルコードのデバッグ 
• デバッガにbinary paste もしくは ランチャーを使う 

– http://practicalmalwareanalysis.com/labs/ 

– シェルコードの静的解析 
• IDA Pro 
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実行されたマルウェアの特定 
• 動的解析でキャプチャした通信の特徴 

– Wireshark 
• TCP80番宛にランダムな256bytesの通信 

• PoisonIvy? 
– Camellia Encryption 

• 最初にチャレンジレスポンスのネゴシエーションを行う 
– https://media.blackhat.com/bh-eu-

10/presentations/Dereszowski/BlackHat-EU-2010-Dereszowski-
Targeted-Attacks-slides.pdf 

– http://labs.alienvault.com/labs/index.php/category/blog/page/3/ 
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Poison Ivyとは 

• RAT(Remote Administration Tool)と呼ばれ、リモートから端末
を操作するためのツールの一種 

• 現状でも配布用Webサイトが生存しており、だれでも入手可能 
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・画面操作 

・マウスやキーボードの操作 

・キー入力の盗聴 

・WebCam(カメラ)の盗撮 

・マイクの盗聴 

・任意のファイルのダウンロード 

 、アップロード、実行 

などが可能 

 



実行されたマルウェアの特定(Cont.) 

• Process Hackerで見てみると・・・ 
• メモリフォレンジックツール（Redline）による検出 

– iexplore.exeが含む特徴的なハンドル名：!VoqA.I4 
• ただし、ビルド時に自由に変更可能 

– コードインジェクションされたとおぼしき領域も存在 

• PoisonIvyのGUIクライアントを起動 
– 該当プログラムが接続に来るか？ 

• デフォルトパスワード(admin)のまま接続可能 
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実行されたマルウェアの詳細解析 
• 補足：コードレベルで特徴を把握したい場合 

– アンパック 
• VirtualAllocEx/VirtualProtectEx等の動的な領域確保・属性変更のAPIに着目 

– デバッグ 
• フラグメント化したコードのインジェクション 

– wmi.exe: explorer.exeへインジェクション 
– explorer.exe: iexplore.exeを起動、マルウェアのインストール、インジェクション 

• iexplore.exe 
– クライアントへの接続を開始 

– 静的解析 
• shellcodeライクなAPI呼び出し 
• call [esi + *] 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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感染原因に関する調査結果 
• 攻撃のトリガ 

– 攻撃者は2012/10/5  17:05:10にファイルを添付したメールを
送信 

– このWordファイル内に悪性のswfファイルが含まれていた 
• exploitはCVE-2012-1535の脆弱性をついてマルウェアをドロップ 

• インストールされたマルウェア 
– マルウェアのインストールパス 

• ファイルシステム 
– C:/Users/okita/AppData/Roaming/wmi.exe 

• レジストリ 
– HKCU¥Software¥Microsoft¥Windows¥CurrentVersion¥Run 

– PoisonIvyというRATに分類されるマルウェア 
– C&Cサーバ 

• www.fewjriehgusuoh.com 

• 今後は、感染後の影響範囲に関する調査が必要 
– 端末内のデータの詐取 
– そこを踏み台として他端末やサーバへの不正アクセス 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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その後の活動の調査 
• マルウェアが生成された時刻から漏えいしたデータのタイムスタンプ

までの期間を調査 
– wmi.exeの最終更新時刻 

• 2012/10/5 17:05:56 

– a.7z内のaフォルダの最終更新時刻 
• 2012/10/5 18:34:29 

• 漏えいしたファイル名（a.7z）を検索してもヒットしない 
• wmi.exe生成後、大量のレジストリへのアクセスや周辺端末へのログ

イン試行が見られる 
– イベントログの閲覧、フィルタ、検索 

• イベントビューア 
• Event Log Explorer 

– Poison Ivyインストール後の情報列挙か？ 
• 何らかのツールを利用している可能性が高い 

• 2012/10/5 19:44:45にメモリダンプ(C:/Windows/MEMORY.DMP)
を生成、システムクラッシュ 
– ここまでにそれらしきツールのエントリは無し 
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その後の活動の調査（Cont.） 
• wmi.exe実行後から大量のレジストリエントリ発生までの間を再調査 
• フォルダ”t” 

– いくつかの実行ファイルが存在 
• ただし、タイムスタンプが対象期間内ではない 
• 本当に無関係？ 
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アンチフォレンジック(1) 
• タイムスタンプの変更 

– timestomp 
– マルウェアによって一般的に行われる 

• 変更の検出 
– NTFSファイルシステムには２種類のタイムスタンプが存在する 

• Standard Information (SI): 通常参照される 
• File Name (FN): 参照されない、変更するAPIも無い 

– FN属性も含めてタイムラインを生成する(win7usp1-current-with-fn) 
• tフォルダ以下は対象期間内に生成されたファイル 
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MFT Header 
Standard Information 

(SI) Attribute 

Filename 

(FN) Attribute 

Remaining Attributes... 

(e.g., Data Attribute) 

一般にOSやアプリケーションによって 

参照されるタイムスタンプを保持。 

APIによって任意の時間に変更可能。 

更新されにくいタイムスタンプを保持。 

SI属性のタイムスタンプより一般に古くなる。 

APIによって変更できない。 

ファイル毎
の 

メタデータ 

レコード 



アンチフォレンジック(2) 

• ファイルデータ、フォルダのメタデータの上書き削除 
– sdelete.exe 
– マルウェアによってまれに行われる or 時間の経過によ

って自然に行われる 

• 過去のファイルシステムの参照 
– Volume Shadow Copyを調べる 

• ホストのWindowsで調べる場合 
– ddイメージをvhdに変換（vhdtools） 

» 勝手に上書きするのでイメージのバックアップを取っておく 

– Windows7の標準機能でマウント 
– ShadowKitでブラウジング、エクスポート 

• SIFTで調べる場合 
– fdiskでイメージのsector数とunit数を調べる 
– vshadowmountでVSSのイメージをマウント 
– マウントしたイメージからファイルをTSKで抽出、

log2timelineでタイムラインを作成 
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攻撃者がアップロードしたツール 
• 以下のツールをアップロードしている 

– scan.bat 
• ネットワーク・アカウント・ファイル情報の収集 

– wce.exe/wce_x64.exe 
• パスワード/パスワードハッシュのダンプ、pass-the-ticket/pass-the-hash 

– PsExec.exe 
• 遠隔でコマンドを実行 

– PwDump7.exe 
• パスワードハッシュのダンプ 

– timestomp.exe 
• タイムスタンプの変更 

– sdelete.exe 
• フォルダ・ファイルの上書き削除 

– stone.exe 
• トンネリングツール 

– plink.exe 
• SSHクライアント 

– woot.exe/woot_x64.exe 
• ？ 

• 実際にツールが使われたか？ 
– AppCache内には実行痕跡が存在していない 

• 無い場合もそれが実行されていないとは限らないので注意が必要 

– SysInternalsのツールはDEFAULTレジストリにEULAを承諾したデータが入る（キー生成
時刻＝初回実行時刻） 

– wce.exeは実行の度にwceaux.dllをspawnする 
– キーワード検索で総当り的に探す（SIFTのsrch_strings_wrap） 
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2012/10/09 19:05:09 

sdelete実行  2012/10/05 17:35:40 

psexec実行 



wce.exeとは 
• パスワードハッシュのダンプやpass-the-hash, pass-the-

ticketなどの機能を持つ 
– パスワード自体の抽出も可能 
– Pass-the-Hash Toolkitの後継（同じ作者） 

• ハッシュのダンプやパスワードの抽出には管理者権限が必要 
• dll（wceaux.dll）を動的に生成して利用する 

– 運が良ければその痕跡を見つけられることも 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの詳細解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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攻撃者ツール(woot.exe)の解析 

• Stringsコマンドで特徴的な文字列 

kernel32.dll 

IsWow64Process 

ntdll.dll 

NtQueryIntervalProfile 

NtAllocateVirtualMemory 

NtDeviceIoControlFile 

NtQuerySystemInformation 

HalDispatchTable 

PsInitialSystemProcess 

PsReferencePrimaryToken 

PsGetThreadProcess 

127.0.0.1 

cmd.exe 

open 

 

赤：kernel exploitでよく用いられる 

       関数、変数 

緑:特徴的な文字列 
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攻撃者ツール(woot.exe)の解析(Cont.) 

• 検索キーワード: NtQueryIntervalProfile  NtQuerySystemInformation   
HalDispatchTable PsInitialSystemProcess PsReferencePrimaryToken 
127.0.0.1 

MS11-046 or MS11-080? 
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攻撃者ツール(woot.exe)の解析(Cont.) 

• MS11-046 

– この時点でサポートされていたすべてのバージョンのWindows
に脆弱性が存在 

– 要点 

• このセキュリティ更新プログラムは、一般で公開された 1 件の 
Microsoft Windows Ancillary Function ドライバー (AFD) の脆弱
性を解決します。この脆弱性により、攻撃者がユーザーのシステムに
ログオンし、特別に細工されたアプリケーションを実行した場合、特
権が昇格される可能性があります。これらの脆弱性が悪用されるには
、有効なログオン資格情報を所持し、ローカルでログオンできること
が攻撃者にとっての必要条件となります。 

– http://technet.microsoft.com/ja-jp/security/bulletin/ms11-046 
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攻撃者ツール(woot.exe)の解析(Cont.) 

• MS11-080 
 

 

この脆弱性の対象がXP, 2003のみなので、 

Windows7で動作するMS11-046の方が有力 http://technet.microsoft.com/ja-jp/security/bulletin/ms11-

080 
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攻撃者ツール(woot.exe)の解析(Cont.) 

• MS11-046 
– 前項までの情報をもとに、パッチ適用の有無で脆弱性が発動するかを

確認するか、もしくは・・・ 

 

– 検索結果から、いくつかのコードを読むと以下のことがわかる 

• NtDeviceIoControlFile で指定するdwIoControlCode が0x12007（
AfdConnect）の時、その戻り値（４バイト）を任意のアドレスに書き込め
る 

• これを使って任意のコードのアドレスをHalDispatchTable + 4に書き込む 

• NtQueryIntervalProfile（HalDispatchTable+4）を呼び、任意のコードを
実行 

 

 

 

コードレベルでExploitの挙動を確認する 

67 



攻撃者ツール(woot.exe)の静的解析 

• 補足：静的解析による大まかな挙動の把握 
– アドレス１(ページ０に切り捨て)にシェルコード用の領域を確保 

• シェルコードはSystemプロセスのトークンを現在のプロセスにセットするコー
ド 

– NtDeviceIoControlFileのコードのメモリ属性を変更、フックのインストー
ル 

• フック先ではIoControlCodeをチェック 
– 12007hの場合、出力バッファをHalDispatchTable + 4を上書きするようセット 
– 戻り値を０にすることでページ０をHalDispatchTable + 4が指すようにする 

– connectを呼び出してNtDeviceIoControlFileを間接的に実行 
– NtQueryIntervalProfile（HalDispatchTable+0x4）をコール、シェルコ

ードを実行 

フックのインストール 

フック先の処理 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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感染後の影響範囲に関する調査結果 
• ツールの種類やファイルシステムのタイムスタンプ、漏洩したファイルの内容やタ

イムスタンプ、ファイルサーバのログ等から、以下の行動が推測できる 
– 2012/10/5 17:10:33 

• ツールのアップロード 

– ？（ツールのアップロードからpsexec実行までの間） 
• CVE-2011-1249を悪用するプログラムとwceを用いて、感染端末内のパスワードやハッシュ

を取得 

– 2012/10/05 17:35:40頃 
• psexec/wce等を使い、pass-the-ticket？でなりすましを行い、他の端末に侵入 

– 2012/10/05 18:35:44頃 
• 取得した情報を圧縮ファイルa.7zにまとめ、ダウンロード？ 
• a.7zに含まれるハッシュ取得のログやDBファイルから、ドメイン管理者権限を取得された可

能性大 

– 2012/10/09 17:40以降（ファイルサーバのイベントログ） 
• 重役アカウントでのファイルサーバへのアクセス 

– 2012/10/09 18:07:45頃 
• 取得した情報を圧縮ファイルb.7zにまとめ、ダウンロード？ 

– 2012/10/09 19:05:09頃 
• アンチフォレンジックとしてツールのタイムスタンプ変更、圧縮ファイルの完全削除を実施 

 
• 他の端末にいつ頃侵入したか等については、他の端末やサーバを調査しなければ正

確に把握できない 
– 認証系のイベントログ 
– psexecの実行痕跡（PSEXESVC） 

• 削除ファイル（psexesvc.exe + リモートで実行されたexe） 
• レジストリの削除領域（サービスの登録）、ページファイル内の実行ファイルパス, etc.. 
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本ケースの解析内容 
• タイムラインの作成 
• 感染原因に関する解析 

– 自動起動設定プログラムの調査（ハンズオン#1） 
– マルウェアの登録時刻の特定 
– タイムラインの解析（ハンズオン#2） 
– 悪性文書ファイルの解析（ハンズオン#3） 
– シェルコード・マルウェアの解析 
– 調査結果 

• 感染後の影響範囲に関する解析 
– その後の活動の調査 
– 未知のバイナリの解析 
– 調査結果 

• まとめ 
– インシデントのタイムライン 
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インシデントのタイムライン 
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最後に 

• インシデントレスポンスではフォレンジック解析・マ
ルウェア解析を組み合わせて以下を明らかにしていく 
– マルウェア感染の有無、種別、機能 
– 感染原因 
– 被害範囲 

• 実際のディスクイメージはよりカオスなので、数をこ
なして経験値を上げていく 
– AVや管理者による検疫・削除、設定変更 
– 大量のデータ、用途不明なプログラム群 
– 調査開始までのタイムラグ 

• フリーのツールでもある程度までの解析は可能 
– より効率的にやりたい場合は商用ツールを使う 

• IDA Pro 
• EnCase/X-Ways Forensics 
• etc.. 
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参考URL 
• フォレンジック解析 

– SANS SIFT Forensic Workstation 
• http://computer-forensics.sans.org/community/downloads 
• Digital Forensic Framework 

– http://www.digital-forensic.org/ 

• log2timeline-siftで、タイムライン生成時に$fn（$filename）属性タイムスタンプも含めるための変更箇所 
– http://list-archives.org/2012/07/10/dfir-lists-sans-org/log2timeline-vs-log2timeline-sift/f/4359338113 

• vshadowmountを用いたVolume Shadow Copyボリュームのマウント手順 
– http://code.google.com/p/libvshadow/wiki/Mounting 

– AutoRuns 
• http://technet.microsoft.com/ja-jp/sysinternals/bb963902.aspx 

– FTK Imager 
• http://accessdata.com/support/product-downloads 

– Registry Decoder 
• http://www.digitalforensicssolutions.com/registrydecoder/ 

– Prefetch Parser 
• http://computer-forensics.sans.org/blog/2010/02/12/prefetch-parser-v1-4/ 

– ShimCacheParser 
• https://github.com/mandiant/ShimCacheParser 

– Web historian 
• http://www.mandiant.com/resources/download/web-historian 

– JumpLister 
• http://www.woanware.co.uk/?page_id=266 

– Redline 
• http://www.mandiant.com/resources/download/redline/ 

– Event Log Explorer 
• http://www.eventlogxp.com/ 

– vhdtool 
• http://archive.msdn.microsoft.com/vhdtool 

– ShadowKit 
• http://redrocktx.blogspot.jp/p/shadowkit.html 

– TSK 
• http://www.sleuthkit.org/ 
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参考URL (Cont.) 
• マルウェア解析 

– FileInsight 
• http://www.mcafee.com/us/downloads/free-tools/fileinsight.aspx 
• FileInsightで利用できるドキュメントマルウェア解析用プラグイン 

– https://github.com/nmantani/FileInsight-plugins 

– REMnux 
• http://zeltser.com/remnux/ 

– OfficeMalScanner 
• http://www.reconstructer.org/code.html 

– PDF Stream Dumper 
• http://sandsprite.com/blogs/index.php?uid=7&pid=57 

– SWFInvestigator 
• http://labs.adobe.com/technologies/swfinvestigator/ 

– IDA Pro Free 
• http://www.hex-rays.com/products/ida/support/download_freeware.shtml 

– OllyDbg 
• http://www.ollydbg.de/ 

– Immunity Debugger 
• http://debugger.immunityinc.com/ 

– libemu 
• http://libemu.carnivore.it/ 

– process hacker 
• http://processhacker.sourceforge.net/ 

– captureBAT 
• http://www.honeynet.org/node/315 

– regshot 
• http://sourceforge.net/projects/regshot/ 

– FakeNet 
• http://practicalmalwareanalysis.com/fakenet/ 

– NT Kernel Resources: PsExec Internals 
• http://www.ntkernel.com/w&p.php?id=15 
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参考URL (Cont.) 

• Exploit 
– CVE-2012-1535 

• http://contagiodump.blogspot.jp/2012/08/c
ve-2012-1535-samples-and-info.html 

• http://contagio.deependresearch.org/docs/
CVE-2012-1535-Adobe-Flash-Player-
Integer-Overflow-Vulnerability-Analysis.pdf 

• http://labs.alienvault.com/labs/index.php/2
012/cve-2012-1535-adobe-flash-being-
exploited-in-the-wild/ 

– CVE-2011-1249 (MS11-046) 
• http://www.exploit-db.com/wp-

content/themes/exploit/docs/18712.pdf 
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お勧め文献 
• フォレンジック解析 

– File System Forensic Analysis 
– Windows Forensic Analysis DVD Toolkit 
– Mastering Windows Network Forensics and Investigation 

• マルウェア解析 
– アナライジングマルウェア 
– Rootkits: Subverting the Windows Kernel 
– The Rootkit Arsenal 
– Malware Analyst's Cookbook and DVD 
– Practical Malware Analysis 

• その他 
– はじめて読む486 
– IDA Pro Book 
– Windows Internals（インサイド Microsoft Windows） 
– Reversing: Secrets of Reverse Engineering 
– 解析魔法少女美咲ちゃん 
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